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AGCC 3.0.1 Release Notes 
 
GeneChip Command Console (AGCC) version 3.0.1 allows you to control the GeneTitan Multi-
Channel (MC) instrument for use with expression and next generation genotyping array plates. 
The following document provides information about known issues in GeneChip Command 
Console (AGCC) version 3.0.1. Other minor enhancements include the ability to install the 
GeneTitan protocols using the library file installer. AGCC v3.0.1 addresses the following issues 
that existed in AGCC v2.0 

 
1. Using AGCC 2.0 to perform Regular sample registration using a tiling barcode will fail 

with the resulting error message: "No matching probe array type is found for the barcode 
xxx. Please verify that the library files are installed for the matching probe array type." 
 

2. The AGCC installer set the COM port to 3. If the COM port for the fluidics control is set to 
a different COM port number then the FluidicsSetting.ini file must be modified to allow 
communication between the Fluidics Control and the FS450. 

 
3. AGCC Fluidics Control will not resume if no sample is selected prior to running the 

protocol. 
 

4. Unable to import HT array files from a network drive if some of the folders on the network 
drive have different security permissions. 
 

5. There are some gridding differences between AGCC 1.1 and AGCC 2.0 for miRNA 
arrays. The data is not affected; this is only an issue with displaying the grid lines. 
 

6. Error “Bottle pressure too low or intermittent” occurs during scanning. 
 
Installation/Upgrade Requirements for AGCC 3.0.1 

• AGCC 3.0.1 installation is capable of upgrading previous AGCC systems as well as 
installing on systems without AGCC.   

• AGCC does not need to be uninstalled when upgrading.   
• Upgrading from AGCC 2.0 to AGCC 3.0 to AGCC 3.0.1 

This is relevant only for the 3.0.0 to 3.0.1 installation scenario, predicated on the system 
originally started with 2.0. 
 
AGCC 3.0 to 3.0.1 installation results in lost Data Roots, which will impact the Projects, 
thus you will not see your Projects either in the WebUI.  This is due to the 
Calvin.System.config being removed from C:\Command_Console\Configuration during 
uninstall.   
 
This only happens if you had a previous upgrade (meaning 2.0 to 3.0 to 3.0.1).  There 
was a dated config file that was backed up from the upgrade 2.0 to 3.0 that was still 
present.  Apparently, the 3.0.1 installation used that dated config file instead of the 
current backed up config file for the 3.0 to 3.0.1 installation.  Thus data roots created in 
3.0 were not seen since the config file being used was from the 2.0 to 3.0.0 install. 
 
The SC fluidics protocols for GeneTitan are not present as well.  They were removed 
from C:\Command_Console\Fluidics\96F.  AGCC 3.0 and 3.0.1 will not install these files.  
They were originally installed from 2.0. 
 
To avoid the above issues, follow the steps below when upgrading: 
1.  Uninstall 3.0.0.  Manually use the Add/Remove method or use the AGCC setup.exe 
will result in the same outcome. 
2.  Install 3.0.1. 
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• If the default path for project or folder was changed in AGCC 2.0, upgrading to AGCC 
3.0.1 will reset the path back to the original default path location of 
C:\Command_Console\Data\Default. 
To set the new default project location, click on Administration-> Project->Manage 
To set the new default path location, click on Data->Default Folder 

 
 

The following are known issues in AGCC 3.0.1: 
 
AGCC Installer 

1. When installing AGCC 3.0.1 on a German Operating System, a warning may display 
during SQL Express installation.  Click OK to continue as this has no impact on the 
installation. 
 

2. When upgrading to or uninstalling/reinstalling AGCC 3.0.1, it is strongly recommended to 
back up your data as well as config files.  Failure to do so may result in data loss. 

 
GeneTitan Instrument control 

3. Activating the About HT96CC menu while the fluidics process step is in progress will 
cause the gripper to pause.  To avoid the interruption, do not open the About HT96CC 
menu while the fluidic is running. 

 
GCS 3000 Instrument control 

4. Users are not prompted to choose the probe array type when performing a drop and scan 
where there are multiple design types.  The workaround is to pre-register when 
performing a drop and scan on these types of arrays. 

 
Fluidics Station 

5. When running any fluidics protocol in an English UK regional setting, the date format will 
still be displayed in US English format. 
 

6. Running the miRNA array type in the AGCC Fluidics Control and selecting all compatible 
protocols will not show any fluidics protocol compatible with miRNA. 
 

 
AGCC Viewer 

7. When creating JPG using multi-color DAT file, the memory usage does not get released if 
user launches subsequent image viewer while the JPG is being generated.  Do not 
launch another viewer while the JPG is being generated. 
 

8. If user has the JPG file displayed, and click on File->CEL file from the image pane 
toolbar, an error “File could not be found. Please verify that the file exists and is 
accessible” will occur.  Use File->Open File to view the associated CEL file. 
 

9. In Windows 2003, if user realigns the grids of the DAT file immediately after the first 
alignment, an error "The software was unable to execute the algorithm.  Cannot create 
Array file:  The request failed with HTTP status 401: Unauthorized" will occur.  Wait a few 
minutes prior to realigning the grids. 
 

10. When all DAT, CEL, and JPG files are opened, if after gridding the DAT file and user 
attempts to exit the Image Viewer without saving, the image viewer will cause the CEL 
and JPG file to be blank.  Close the CEL or JPG file and reopen to restore the image. 
 

11. When viewing single channel DAT file, the Full Image button is disabled.  This behavior is 
by design.  The user should not be able to click full image because only sub-image is 
shown. 
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12. Clicking on Default does not reset the Min Intensity & Max Intensity values to default 

when both values are set to zero.  To get the values set back to the default, change the 
contrast from the dialog or from the toolbar and reset by clicking the Default button. 

 
AGCC Portal 

13. Opening the ARR file of HT array type that was generated by the Image Viewer will result 
in an error “The mediaRow parameter must be an integer between 0 and 25 (A and Z).”  
This does not affect the data in any way. 
 

14. When registering a Sample Prep Plate, having an apostrophe in the sample name will 
result in a registration error, “Syntax error in the expression.”  Do not use the apostrophe 
in the sample name. 
 

15. Results will display both old sample name as well as renamed sample name if user 
performs a search immediately after renaming the sample name.  Allow time for the 
indexer to get updated to avoid seeing duplicate sample name. 
 

16. Using Firefox browser version 3.5 will get a warning message that it’s not supported.  
However, using this version will not have any impact on the functionalities of the 
application. 
 

17. An error “not valid number” will occur when attempting to save a template attribute using 
comma as a number separator.  Do not use comma separator in numeric data value. 
 

18. When batch editing a template that has a date field in UK regional settings, user will get 
an error “Error parsing mm/dd/yyyy as a Date type.”  Adjust the date values to use the 
date format in the machine locale, or alternatively, reset the machine locale to use the 
US-English date format. 
 

19. When batch editing, the edited values for required attribute sample name remain 
unchanged.  To change this, Delete the “required” tag from the user attribute headers in 
the batch edit excel file. 
 

20. An error “Can’t show properties for task AGCC Data Uploader” will occur when launched 
from the AGCC Launcher on Windows Vista Business.  The task does get created but 
cannot be linked from the Launcher and needs to be configured manually.  Refer to the 
user manual for detailed instructions on how to configure manually. 

 
AGCC Registration 

21. An error “Specified time is not supported” will occur when registering a sample on an 
Arabic Operating System.  The workaround is to switch the locale (regional settings) to 
US-English or other usable locale. 

 
 
 
The following are known issues that existed in previous versions of AGCC and not 
addressed in AGCC 3.0.1: 
 
AGCC Installer 

1. User must have local administrative rights in order to configure Email Configuration 
Editor. 

 
2. When installing AGCC it is recommended that user do not change the default path as 

doing so may have adverse affect. 
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3. An exception error may occur on a Windows XP-SP3 environment after installing AGCC 
2.0. Simply close and restart the AGCC launcher. 
 

4. After upgrading to or re-installing AGCC 2.0, the network data roots need to be re-
configured with appropriate permissions. Refer to the “How to configure network data 
storage” tutorial at www.affymetrix.com for more information. 
 

5. On some instances, AGCC fails to install on Windows 2003 Server with a “1603 fatal 
error" message. Browse to the “temp” (environment) directory, delete all temporary files, 
restart the server, and then launch the install. 
 

6. When uninstalling a previous version of AGCC, you must delete the “C:\Program 
Files\Microsoft SQL Server\90” folder prior to installing AGCC 1.1. 
 

 
7. Sometimes after installing AGCC/DEC on a Windows 2003 Server, an error “IIS Worker 

Process” may occur. This error may occur initially after an initial install. Click on “close” 
and the application works fine. 
 

8. Installing AGCC Workgroup version on Windows 2003 Server does not check the Service 
Pack level. The supported configuration must have SP2 installed. 
 

9. On rare occasions, after installing AGCC, the AGCCIndexer service does not start and as 
a result users will see an error in Folder view. The workaround is to start the indexer 
service. For this, right click on “My computer”, select “Manage”, click on “Services and 
Applications”, click on “Services” and start “AGCCIndexer” service. 
 

10. Installing AGCC on a workstation with the GeneChip HT Scan Control connected to a 
96S will overwrite the drivers to communicate with the 96S scanner. To enable 
communication the GeneChip HT Scan Control needs to be reinstalled after AGCC 2.0. 

 
GeneTitan Instrument Control 

11. Selecting the Help menu on the GeneTitan Control UI while the instrument is running will 
temporarily halt the gripper in GeneTitan instrument until the help menu appears on the 
screen. Users are warned against selecting the help menu while the gripper is performing 
any operation in the instrument. 
 

12. End of process email alerts from the GeneTitan Control also indicate start of the next 
process (e.g. users will receive alert for hyb completed, but not for wash-stain started 
since it is started right after hyb is completed). 
 

13. On rare occasions, launching scanner service app from, 
(C:\programfiles\affymetrix\GeneChipHTScanControl\Scanner96SA.exe) generates error 
message. The workaround is to un-plug and re-plug the power cable of the scanner. 

 
 
GCS 3000 Instrument control 

14. When setting up email alerts using the AGCC Email Configuration File Editor, the Save 
button is not enabled if the check box in the title row is not selected. In order to enable 
the Save button, click the top checkbox to select all, and then deselect the messages that 
you do not wish to receive email notification for. 
 

15. On certain occasions, when performing a full autoloader scan, the first array will scan 
successfully but fails to eject causing the scan control to halt. 

 

http://www.affymetrix.com/�


AGCC 3.0.1 Release Notes, Revision 3  Page 5 of 11 

16. An error will occur when scanning data to an external SCSI drive. On instrument control 
workstations, the default data root cannot be set to an external USB drive.  Please scan 
to an internal local drive, and use external drives such as SCSI or USB for data storage.   

 
17. When performing a scan on a GCS3000 in manual mode, HT array will appear in the 

drop-down. Select the appropriate array when scanning. 
 

18. When scanning an array if the C:\ drive runs out of free disk space, an error message 
"Failed to write the output CEL file.  Corrective actions are to verify that the folder exists 
and there are read/write permissions on the output device.  Code 16" will occur. 
 

19. Enabling screensaver and power save mode will result in loss of communication between 
fluidics and scanner components of GeneTitan instrument. Do not enable screensaver 
and power save mode on the workstation connected to the GeneTitan instrument. 
 

20. On rare occasions, users might get a “Leak Detected” error message. Please contact 
your Field Service Engineer if this happens. 
 

21. User defined fluidics protocol values are overwritten without warning when fluidics script 
is reinstalled. 
 

22. Fluidics information entries such as Stage, Time Cycle, etc. will be blank on non-English 
instrument workstation. 

 
23. If a network disconnect occurs between the workstation and the scanner during a scan, 

the application will not automatically re-establish a connection. The user must close the 
instrument control window and re-launch the application. 
 

24. If the service user has access to a sample file and the logged in user does not, the 
system will still allow the logged in user to scan the array and the scan will be created in 
the designated folder location. 

 
AGCC Viewer 

25. When using the manual grid function, sometimes CEL files are not displayed correctly at 
certain zoom in levels. 
 

26. When changing the minimum/maximum contrast settings, resetting the values back to 
default does not work. Click and hold the right mouse button while dragging and the 
contrast will be updated. 

 
27. “Regenerate CEL Intensities” operation on GeneTitan data, results in a blank image after 

the algorithm is completed. Click on Full Image to refresh the CEL image. 
 

28. Files that are not present within the AGCC data root cannot be opened using the “files” 
option in the tool bar of the image window in the viewer. In order to open these files use 
the “Open File” option in the main image viewer window. 
 

29. Command Console viewer will crash if a file is closed while the image is updating, 
particularly if the data is on the network, No data is lost, simply re-open the viewer. 
 

30. AGCC will not grid some miRNA DAT files and generate CEL files. Users can create a 
DTT archive from DEC and import into GCOS using to grid and generate CEL files. If the 
data is required to be in AGCC format then DEC can be used to convert the GCOS data 
to AGCC format. 
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AGCC Portal 
 

31. In certain environments, users may get an error, "A column named Project Name already 
belongs to this data table" when viewing in Folder View. The workaround is to remove 
C:\Command_Console\Logs\UserSettings.xml and reopen the folder view. A new 
UserSetting.xml will be created. 

 
32. When editing a sample which contains attributes from a template that no longer exists on 

that workstation, the conversion window will display an “original attribute” table with all 
the information (including the values for the attributes) and a “converted attribute” table 
with all the information, but does not show the values.  This does not mean that the users 
will lose the values if they choose to convert. 
 

33. When creating an ARR report without selecting any files, the error message “Files not 
selected. Please wait” is not cleared from the screen. Users will have to navigate away 
from this page and return to it to perform repeat the “Create report files command” 
 

34. During Batch Edit process, if users want to add a template to a sample file, the desired 
template must be selected while creating the batch edit file. This is applicable even if the 
batch edit file being created contains some sample files that already have the desired 
template(s).  

 
35. When sample files containing type definition mismatch for attributes is opened in the 

WebUI, these mismatched fields will be highlighted in yellow.  If this appears, please 
correct the mismatched fields in the WebUI. If mismatch is not corrected, no data is lost. 
The field will always be highlighted until the mismatch is corrected. 
 

36. In the GeneTitan ARR files, the CreatedDateTime stamp indicates the UNC time and 
whereas the hybridization start and end time is the local time (e.g. PST or EST).    
 

37. When performing a data upload operation, if the operation is terminated after the DAT 
and CEL files are uploaded or if only DAT and CEL files are selected for upload, the 
auxiliary files (JPG, CEL summary report etc.) will not appear in the files to upload list 
again. Users will have to manually copy these files to the destination location.  
 

38. When uploading a file that has the same filename as the file on the destination, the name 
of the second file uploaded will be incremented at the destination location    and no error 
is reported. For example, if the destination location has a file, test.DAT and user tries to 
move another file with the same name, the second file will be names as test_2.DAT 

 
39. When copying a project, only ARR, AUDIT, DAT, CEL, and CHP are available. JPG and 

RPT (and all other non-Affy file type) files are not part of the option. Users will have to 
manually copy these files to the destination location. 

 
40. When editing a sample file from the UI to change the probe array type, if the “Derive 

array name from the sample file’s name” option is enabled during registration, the array 
name does not get updated automatically. User must uncheck the “Derive array name 
from the sample file’s name” box and update the array name manually. 
 

41. When copying a project on AGCC Workgroup from a remote machine, the destination is 
referring to the path on the server, not on the local workstation. 
 

42. The error “page not found” will occur when creating a report on a project that contains # 
or % in the name. This only happens on AGCC workgroup. 
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43. When using the file upload function, GRD and CEL Summary Report files will not upload 
if data root is on a network share and the DAT file is not present. To move the files to the 
network share, manually move the files. 
 

44. When using the Add Barcode feature, the list that is returned may contain sample files 
that already have a barcode. 
 

45. If a project was originally associated with a data root that has been removed from the 
AGCC view, but not deleted from the file system, the data still exits. Future data saved to 
that project will be saved in the original folder but will not be viewable in the AGCC Portal 
views. To view this data, assign the data folder to an AGCC project and move the folder 
to an AGCC data root.  
 

46. AGCC uses the local settings of the computer to determine the date and decimal syntax, 
therefore, using a batch editing or registration file on a computer with different local 
settings may cause the data to be misinterpreted. For example, a batch registration file 
created on a computer using US English local settings and uploaded to a computer using 
German local settings will cause the decimal place to be misinterpreted. (e.g. 1.2 => 
12.0) To avoid this, create or resave the batch file on the same computer it will be 
uploaded on.  
 

47. Clicking rapidly between project folders using the Folder view in the AGCC Portal may 
cause an error stating “this.get_element().style is null or not an object” to be displayed. 
Simply refresh the screen to continue using the system.  
 

48. GCOS data can exist in AGCC, but not all of the functionality of AGCC works on GCOS 
data.  
a. GCOS data is not visible in the Project View. To find GCOS data associated within a 

project use either the folder view, or advanced search. 
b. GCOS data is only searchable by file name, file modification date, and project, not by 

sample attributes.  
c. GCOS data cannot be opened in the AGCC Viewer. 
 

49. File and folder names should be consistent for:  
• Array Name 
• Sample File Name  
• Template Name  
• Project Name  

These are valid characters for file and folder names:  
• Only Basic Latin letters (A-Z, a-z), digits, spaces and !#$%&'()+,.-;=@[]^_`{}~ 

characters are allowed. 
• AGCC & Windows OS will not allow \ / : * ? " < >  

 
50. If a user is logged on and then uses Microsoft’s “Switch User” feature, the data 

access/permission will be determined by the first user logged on. If you want different 
data access/permission, have the initial user log off and log on as the user you want.  

 
51. Sample files generated using beta software versions will not be distinguished from files 

generated in the released version. There is no version marked in the file.  
 

52. When launching AGCC Portal using Firefox web browser, an error “Windows cannot find 
“http://localhost:8000/AffyWeb/Default.aspx” or "Unhandled exception has occurred in 
your application” may occur. The error message only appears initially and does not have 
any adverse affect to the application or data. Click OK and continue on with the 
application.  
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53. A template name can only be 221 characters. If it is more than 221 characters, the 
application will crash.  
 

54. Tiling array does not get auto-populated when registering sample. The user must select 
the appropriate Probe Array Type form the pull down menu. 
 

55. Batch registrations will fail if the associated template contains control vocabulary that 
exceeds 252 lines. 

 
Array Registration 

56. Leaving a sample file unsaved for 20 minutes during basic sample registration can cause 
the system to timeout and requires re-entry of the data. To avoid this issue, save the 
sample file before beginning another operation on the computer or walking away from the 
computer. 
 

57. When registering a sample with a template that contains attribute of Date type, entering a 
value with one decimal of Number type (e.g. 4.1) will automatically be converted to date 
type (i.e. 4/1/08). 
 

58. When batch registering samples with a combination of Affymetrix and custom barcodes, 
with the “Allow custom barcode” option enabled, the error “Probe Array Type is empty. 
Please specify Probe Array Type” will occur for samples with Affymetrix barcode if a 
probe array type is not specified.  Specify the probe array type for samples with 
Affymetrix barcode. 
 

59. In certain Windows 2003 Server environments, users may not be able to upload a batch 
register file in Excel format with user attributes. To perform the upload, grant Read & 
Execute permissions to “Everyone” on the Windows 2003 server’s C:\Windows\Temp 
folder or upload in TSV format. 
 

60. During cartridge batch registration process, if the registration excel file has errors related 
to array names, sample files are not created for samples starting from the erroneous 
sample. The workaround is to correct the mistake, remove any already registered 
samples from the file and try the registration again.  
 

61. For cartridge batch registration, the probe array type must be specified even if  the array 
barcode is provided. 
 

62. During batch registration process, AGCC is not reporting error for Sample file names or 
Array names that have invalid characters (<>*?/\"|:), however an error is reported when 
these files are viewed in the WebUI. These (<>*?/\"|:) characters should not be used in 
Sample file names or Array names. 
 

63. Quick Registration does not allow users to register multiple arrays with same sample 
name. Use Batch Registration when registering multiple arrays with same sample name. 
 

64. In batch registration or editing operation, in some scenarios, multiple error messages 
may be displayed for a single issue/error. 
 

65. When uploading a file with large number (500+) of samples, an error “Unable to connect 
to the remote server” will occur. If this error occurs, reduce the number of samples to be 
uploaded to 500 (as recommended on the Batch Registration UI). 
 

66. Using the character sequence “&#” to create Sample File Names, Array Names and 
Templates will cause the application to crash. 
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67. “HT Plate Registration” does not support custom barcodes in this release. 
 

68. When registering a Citrus or Tiling array, use the AGCC Portal to register the samples. 
Using HT Sample or Batch Registration will not work for this array type. 
 

69. If you use the Quick Register feature and change the default project folder, the files are 
not saved to the new location. To avoid this, use basic or batch registration. You can also 
move the files manually to the appropriate folder. If the files are not in the selected folder, 
you can use the Search by Project feature to locate the registered files.  
 

70. Using batch registration requires the Excel worksheet name to be “samples”, otherwise 
batch registration will not work. 
 

Fluidics Station 
71. Inaccurate fluidics incompatibility warning for FS450_0001 script and Drosophila Tiling 

2.0R array. Disregard the warning. FS450_001 is the correct script for Drosophila Tiling 
2.0R array. 

 
72. Audit file will list all steps in the fluidics protocol even for steps that are skipped or failed. 

 
Array Searching 

73. Sometimes on Windows 2003 server, the search result returns files with blank 
information.  Click the File name header to display the file information. 
 

74. Basic search does not return result if searching for date attributes (e.g. 06/04/04) that are 
defined as type text. 
 

75. In basic search, the “OR” logic does not return results when performing a combination 
search by Number or Date attribute. Use Advanced Search option to perform 
combination searches. 
 

76. When performing an advanced search with a template of number or date attribute set to 
“any value”, the search will not return any result. 
 

77. Advanced Search does not return result when selecting multiple projects/files. Select one 
project/file at a time. 
 

78. Basic Search does not return result when searching for GeneTitan Plate barcodes or 
cartridge barcodes. Use the Advanced search option 
 

79. Searching by “Array Name” returns only the ARR, DAT, CEL, and CHP files, and not the 
JPG, Audit and CEL summary report files. 
 

80. When using basic search, do not use a comma to search for multiple attributes. AGCC 
basic search will return no results when a comma is used in the search criteria. To avoid 
this, use a wildcard or the “or” logic in the search criteria instead of a comma.  
 

81. On the Advanced Search by date feature, users can only change the date month by 
month to a specific date. There is not a way to enter a specific date in this release.  
 

82. If using Advanced Search and more than 25,000 files are returned, you may receive a 
“SOAP exception error”. To work around this, narrow your search so that fewer files are 
returned. 

 
DEC 
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83. After importing mini DAT files, the column’s name is displayed as “DAT” rather than “mini 
DAT.” After the GCOS data is imported into AGCC, the 98 miniDAT files are consolidated 
into a single AGCC format combined DAT file. 

 
84. When importing the HTAPS data into AGCC, the “Find files to import” operation looks for 

data upto two levels down from the root folder specified by the user. 
 

85. When reconnecting data, the reconnector will move all ARR files to an obsolete folder 
including ARR files that contain more than one physical array. Browse to the obsolete 
folder to look for the ARR files. Note: The obsolete folder is created in the same folder 
that the user selects as the source folder for the reconnect operation. 

 
86. The error "An item with the same key has already been added" may occur on certain 

resequencing files when importing from a network drive. Move the files to a local drive if 
this occurs. 

  
87. Exporting of resequencing or Mapping CHP file(s) is not supported. 

 
88. Importing of Mapping CHP file(s) into AGCC is not supported. 

 
89. Audit file is missing when importing data from a network drive. Move the data to a local 

drive prior to importing. 
 

90. When importing library files, the source and destination folder cannot be the same 
location. 
 

91. If a user renames the destination folder while data is being imported, the import will fail.  
 

92. If the probe array type is changed in an AGCC CEL file and imported into GCOS using 
DEC, GCOS will show the original probe array type name and not the new name.  
 

93. If a user is trying to connect DEC to a GCOS Server, an error message will occur: “Error 
creating MAGE-ML data on the remote system”. You will need to run the “DecOnGcos” 
executable on the GCOS Server. After running the setup.exe from the DecOnGcos 
folder, the user will be able to connect DEC to a GCOS Server. The DecOnGcos folder is 
included with the AGCC install.  
 

94. Using DEC to import the Sample file back to a GCOS system, the fluidics information will 
not be available. To avoid this, use Windows Explorer and rename the AUDIT file to 
match the Sample file name. Use DEC to export the data to GCOS and the fluidics 
information will be displayed in the EXP file. 

 
Performance  

95. Version 1.0 of AGCC has been engineered to provide good user interface and file index 
performance for up to 10,000 experiments (arrays) stored locally on a workstation and 
within an AGCC data root. The computer system specifications used for this testing were 
an instrument control workstation with 2GB Ram and a dual core CPU. It also included 5 
data files for each experiment (sample, DAT, CEL, CHP, and JPG files) resulting in a 
total of 50,000 indexed files. To optimize performance, we recommend storing no more 
than 5,000 total files (data from 1,000 arrays) in any one data folder.  
If your data requirements are outside of these parameters please contact your local 
Affymetrix office for consultation on configuring your environment for optimal 
performance.  

 
96. When using DEC to import/export files, it is recommended to import/export less than 

1000 files for a single run. This operation can take up to approximately 8 hours 
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depending on the size and number of files being imported/exported and the system 
configuration. 
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